bée année

Mission 1

Octobre

Mission 2
Novembre

= MisSion FoSS

6cannée

Mission 3
Décembre

an

Mission 4
Janvier

1

Mission 5
Février

Mission &
Mars

Mission 7
Avril

ible en TIC!

Agents secrets, 3 vos écrans!

Mission 8
Mai

De la grande visite!

Pages

Word |

Utiliser le traitement de
texte pour crire un
mot de bienvenue a ses
parents a l'occasion de
leur visite a I'école.
Rédiger le brouillon
directement au clavier
et s'initier au
correcteur.

Imprimer le message et
le placer sur le pupitre
de I'éléve au moment
de la rencontre.

Note : cette activité
peut se vivre en
septembre.

ou

Mets le robot au défi!
RobotProg

S'initier a la robotigque
par programmation
simple.

Débuter les exercices
du cahier de I'éléve.
Les laisser aller a leur
rythme.

Note : S'effectue sans
matérnel de robotique.

Un commerce, a Noél
Google sketchup |/

Représenter en 3D un
commerce de jouets ou
de décorations de Noél.
Faire trouver l'aire, le
périmétre et le volume
de trois éléments de
leur modeéle par un
ami.

Inscrire les questions
sur la feuille SketchUp.

Qui suis-je?
Pixia [} ou

ArtRage V'

LopArt [V ?

Réaliser une oeuvre
décrivant une scéne
d'hiver en exploitant
les différentes textures
et un matériau de son
choix {gouache, fusain,
etc.). Décrire, par écrit,
les techniques et
procédés utilisés.
Suggestion : dans la
classe, exposer les
images (imprimées ou
sur un TBI). A tour de
role, les éléves lisent
leur description afin de
la faire associer a leur
production.

Encore plus de défis
pour le robot!

RobotProg |V ?

Exploiter la robotique
par programmation
simple.

Poursuivre les exercices
du cahier de I'éléve.
Les laisser aller a leur
rythme.

Note : S'effectue sans
maténiel de robotique.

Quel temps fait-il?
meteomedia.com
Excell [V

A l'aide du site de
Météomédia, réaliser
un diagramme de la
température moyenne
de la ville la plus
proche.

Situation
d'apprentissage ici :
recitmst.qc.ca/
Donnees-meteo-quoi-
en-faire

Un album souvenir
PowerPoint [}/  ou

Keynote

Présenter un souvenir
ou une anecdote
survenue au primaire.
L'illustrer et insérer un
ou des sons.
Assembler les fichiers
des éleves en un seaul
document afin de
constituer un album
souvenir de classe.
Note : prévoir deux
heures pour cette
activite.

Photoroman
souvenir

Comic Life [

Réaliser un photoroman
qui présente une
rétrospective de
l'année.

Suggestion : I'ajouter
au journal des
finissants.

Mission possible en TIC + Julie Aubé et Suzanne Harvey + RECIT CSDC
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Cahier de I’éleve | Robotprog

ROBOTPROG

Exercice 1 I

Reproduis le schéma suivant. Exécute le programme. Enregistre ton programme.

Q Programme robot 1 [;]
o
o b ® Q@ :Pour exécuter le programme...
g (055 ] s n

| A A , .
~ Il Dans le menu Fenétre => Fenétre exécution.

- INIT Si le code contient
Tourner a droite i
une erreur, tu ne
c pourras pas lancer
Cligue sur le programme.
v]

2 0 = W
|

[ outs | [ LGste | PP ] [ —— = —————— —————— 4

N

|
| . . . N
| f Relie chaque bloc d’instruction a
IDans le menu Fichier == Enregistrer programme || sa signification:
: Edition Configuration  Progr :
I Mouweau programme  CerlHM | 4
| salprog | Début
| QuUvrir programme Chrl+0 I
: Enreqistrer programme  Cerl+S : Fin
I Enregistrer sous ... k I
: Fermer el : Tourner
| Cuitker CErl+i | a gauche
|
ety Avancer
|Pour effacer une instruction... . |
[ . . @ ' é) Tourner
IDans les outils, sélectionne I'efface | X )
: l _ a droite
| | (_?_)
| [

1 | Commission scolaire Des Chénes — 2010
Karine St-Georges et Sylvie Guilbault




Cahier de I'éléve

Robotprog

Exercice 2 '

Reproduis le schéma suivant. Exécute ce programme. Enregistre le programme.

=, Programme robot 1

Programme principal

. Objectif I | Aucun

[ Début)

I
| Tourner a droite |

| Avancer

|T|:|urr'|er a gauche|

| Ayancer |

-

Exercice 3 '

Construis un programme qui permet

| Tourner a gauche|

| Avancer |

Avancer

| Tourner a droite |

Fin

Que se passe-t-il?

Que dois-tu changer dans ton
programme pour que ton robot
réussisse a sortir de sa maison?

au robot d’effectuer le trajet vert et
d’atteindre le mur. Vérifie que ton
objectif est bien atteint. Enregistre

:Pour vérifier un objectif... |
|

:Dans la liste Objectif choisis I’objec—:
tif désiré. |

Programme principal

L]
: Objectif I | Aller dewant un mur

2 | Commission scolaire Des Chénes — 2010
Karine St-Georges et Sylvie Guilbault




Cahier de I'éléve

Robotprog

I Dans le menu Terrain == Enregistrer sous...

Exercice 4 '

Construis un programme qui permet

au robot d’effectuer le trajet vert et
d’atteindre le coin. Vérifie que ton
objectif est bien atteint. Enregistre.

Exercice 5 I

Crée un nouveau terrain d’une largeur de 9 cases et d’'une hauteur de 9 cases.
Place ton robot au méme endroit que sur le schéma ci-dessous. Enregistre ton ter-
rain. Construis un programme ou ton robot fait demi-tour. Vérifie que ton objectif

est atteint. Enregistre ton programme.

Pour enregistrer un terrain...
|

Pour créer un nouveau terrain...

ETENN Exécution  Fenét

Modifier

Cigvrir

Enregistrer

Enresgstrer sous ...

|
|
|
Mouveau |
|
|
|
|

3 | Commission scolaire Des Chénes — 2010
Karine St-Georges et Sylvie Guilbault




Cahier de I’éleve | Robotprog

Exercice 6 '

Modifie ton terrain pour qu’il soit identique
a celui ci-contre. Modifie ton niveau d’ou-
tils pour 2. Construis un sous-programme
« ligne » qui permet au robot d’avancer
sur le chemin de cases pales. Enregistre

| Pour changer de niveau...
|
:Dans le menu Configuration ==> Niveau.

. . 5
ICh0|S|r le niveau 2. Fagran

| m
\Clique sur OK. Choisir URSieu

: Arréker de jouer

:Pour créer et utiliser un sous-programme...

| .
(Dans le menu programmation ==>=Nouveau sous-programme.
|

|
|

|

|

_ |

iNomme ce sous-programme ligne. |
|

|

|

|

|

|
:Place les blocs d’instructions pour faire avancer ton robot.

Programme robot 1

Programme principal Sous programme
- Ligne
Objectif ||.~’-‘-.ucun v| fLig

Debut

Avancer

Debut
Avancer

H ligne H

Avancer

Fin

Avancer

e

Avancer

Fin

4 | Commission scolaire Des Chénes — 2010
Karine St-Georges et Sylvie Guilbault




Cahier de I’éleve | Robotprog

Exercice 7 '

Modifie ton terrain pour qu’il soit identique
a celui ci-contre. Construis un programme
—

qui permet au robot d’effectuer un trajet

carré de 6 cases de c6tés. Enregistre ton = -

programme et ton terrain. T S .
W =

—

Exercice 8 .

Réutilise le ton terrain de I'exercice 7 et ton programme. Modifie ton
programme et/ou ton sous-programme pour que ton robot marque son

|Change de niveau pour 4.

I
:Sélectionne I'outil E::ﬂ

Exercice 9 I

Utilise le terrain de I'exercice 5. Ecris un programme qui trace un B ou un C
ou un P ou un R ou un T. Enregistre ton programme.

i — —— — — — . — — . — —— i ——— — ——— o — o — —— ————

:Pour utiliser un terrain enregistré... ) exécution Fend

|
| } L. Madifier :
Dans le menu Terrain => Modifier. |
|
|
|
|

Mouveau

|
:Dans le menu Terrain == Ouvrir. wmegis »

| Enreqistrer sous ...

5 | Commission scolaire Des Chénes — 2010
Karine St-Georges et Sylvie Guilbault




Cahier de I’éleve | Robotprog

Exercice 10 '

Ouvre le terrain « amil ». Crée un pro-
gramme qui permet au robot rouge de
rejoindre son ami le robot vert.

Exercice 11 '

|
|

|

Réutilise le ton programme de I’'exercice :
10 et modifie-le pour que ton robot :Nous aIIons|utiIiser ce bloc . :
|

|

|

|

I . .
IAssurez-vous d’étre dans le niveau 4.
I

compte ses pas. A chaque fois qu’il
avance, on ajoute 1 au nombre de pas.

 nbpas = nbpas+1 |

:Lorsque le programme s’exécute, cliquez
:sur “

Exercice 12 I

Choisis un terrain. Avant d’avancer, ton
robot note sa position de départ. I |Utiliser une variable pour la position
avance jusqu’au mur, fait demi-tour et :horizontale et vertic?le.

revient a sa position de départ.

- T - - LT = T
: Pour enregistrer sa position...

|

: °  horizontale = xrobot
| ]
|

|

|

° wverticale = yrobot

Ton programme fonctionne-t-il peu im-
porte la position initiale de ton robot?

6 | Commission scolaire Des Chénes — 2010
Karine St-Georges et Sylvie Guilbault




Cahier de I'éléve

Robotprog

Projet '

A ton tour de jouer ...

TERRAIN

DEFI

7 | Commission scolaire Des Chénes — 2010
Karine St-Georges et Sylvie Guilbault




Google SketchUp

# Sans titre - SketchUp

Fichier Ecition Affichage Caméra Dessner Outik  Fenétre  Aide

BOC v RBLRISE H2ZAR

»|

2o S P8 XU ZOX <OH R
@@|~%n\a|b*wl'—we» @’n\\}?@

Sélectiormerun espace

Coloner
¢ Sanstitre-SkchhUp /

Rectangle
- . Cercle
SWILGELEN Caméra Dessiner Outils  Fenétre A I'aide de cet outil, fu N
T v v pours choisi:
Onalets d o - le revétement extérieur Déplacer
v Ongiets d scéne I |
P , . - les recouvrements pour
Géométrie cachée e toit po
v Plans de section - les différentes textures
- et plus encore...

i
3

N
§

£

©
®
©

B} Salectionnaz des cbjets. Appuyez sur Maj pour étendre |a sélection. Fartes
Mission possible en TIC e Julie Aubé et Suzanne Harvey  RECIT de la CSDC @ ke ]




Les formes et les couleurs avec Pixia

% Pixda
Fuhvers Edtion Séection Outls Image Affichage Fendtres Ade

a [ [ et 23 6 s R | R~ (Y| | [T] S SS)

® Sans titre [LAYERO] of Précision Standard =3 L WO T 5.
|

Pour le dernier outil qui permet de faire des polygones variés, les cotés se dessinent par
un clic gauche et la fermeture finale par un clic droit.

S Pive
Fedeors Elen Steten Ol Bsage AVOage Ferdions A

BREE DENE e @ AR 2

W Samm 1Nre [LAYERO| of Préchion Standard

On choisit la
couleurici

Le résultat
apparait ici

Pour foncer ou éclaircir,
glisser le curseur.

Pesny | vea
‘4 demarrer

Mission possible en TIC » Julie Aubé et Suzanne Harvey e RECIT de la CSDC



Pour créer des effets dégradés, qu'on ap-
pelle masque filtrant, clique ici.

FPchirs Edtion Sélection Outls Image Alchage Tendtres  Ade

W B I [ (w74 [T et 3 (7 4

By
P Sans titre [LAYIRO] of Précision Standard

senss [ aa™ @ B

Diérue Thngle . < > 0
e [ I
Chyuer drot poor G ure image BEMap comee Mmatque
Ousse OBt

Ceme ] (o] [Ae]

|| [Sar tire] (1500758 pluets] [24 bitn]

Mission possible en TIC » Julie Aubé et Suzanne Harvey e RECIT de la CSDC

On peut ajouter du texte
avec le bouton fexte (A).

Configuration de MOutil Texte

Toxte pixia "

e PIXiQ

Police Anal v Taille 420 <

® Horizontale O Verticale

DGras Oralique DOusse O Cortours

omus € o

Ombre ¢ > 0 Opacité < > 3
| OK ) [ Anowler |

On peut modifier la taille , la po-
lice de caractére, modifier
l'orientation et mettre un
masque filtrant




Quel temps fait-il2

Créer un graphique de température avec Excell

recit

1. Rends-toi sur le site de Météomédia : [% http:/ /www.meteomedia.com/

7, Méteo
Media
Accueil | Aide | Concours

2. Choisis la section Météo > Statistiques

» Statistiques

3. Trouve la ville la plus proche de ton école.

Alberta

Manitoba

Terre-Neuve et Labrador
Nouvelle-Ecosse

Ontario

—3Québec -y Drummondville
Yukon

4. Dans la section Température, sélectionne les 4 premiéres rangées (clique et glisse)
(mois, Maximum moyen, Minimum moyen et Moyenne de température).

Température (°C) Plus de statistiques sur les températures »

J F M A M J J A S 0 N D

Maximum moyen -58 -4.1 2 104 189 236 26 244 19 12,2 46 26
Minimum moyen -155 -137 -74 06 74 12,8 15,6 14,2 94 36 -2,6 -1

Moyenne de température -107 -89 2,7 55 13,2 18,2 20,8 19,3 14,2 79 1 6,8

5. Copie-les (Edition > Copier ou Ctrl + C au clavier).

Mission possible en TIC e Julie Aubé et Suzanne Harvey « RECIT de la CSDC



6. Ouvre Excell

7. Sélectionne la cellule A1
Avec le bouton de droite,
choisis Collage spécial...

8. Clique sur Texte puis sur OK.

|5€] Microsoft Excel - Classeurl A B I
(] Fichier Editi 1
: _J Fichier Edition Affic > Couper
2 =2 p ¢ ) F—— |
N EE R 37128 copier
H = = - = |1
: ( N8 4] 4| Coller
ol 5| —
Al - A 6 | Collage spécial...
A B 7 ‘ Insérer...
1
| 2 |
| 3 |
| 4 |
Collage spécial @
soures o« ]
En tantque : Annuler
@ Coller : HTML -
Coler avec fason
Afficher sous

forme d'icone

Résultat

Insére le contenu du Presse-papiers en tant
I' que texte mais sans aucune mise en forme.

9. Sélectionne les cellules avec du contenu.

Insertion > Graphique... Insertion i Format Outils Donr
u Cellules...
3 K v Lignes
0 N D : Colonnes
14,2 7.9 1 -6.8 Feuille
19 12,2 46 -2.6 h@ ﬁa hi ||
phique...
9.4 3.6 2.6 -111 -
:l Caractéres spéciaux...

Mission possible en TIC e Julie Aubé et Suzanne Harvey « RECIT de la CSDC




10. Choisis le type de graphique approprié puis clique sur Suivant.

Assistant Graphique - Etape 1 sur 4 - Type de Graphique

Types standard | Types personnalisés

Type de graphique :
I T -

E Barres
@ Courbes

v ] Secteurs

..~ Nuages de points
‘ Aires

re ] Anneau

@r Radar

@ Surface

®¢ Bulles =
el

(2 |l

Sous-type de graphique :

m

Histogramme groupé avec effet 3D.

Maintenir appuyé pour visionner ]

Assistant Graphique - Etape 2 sur 4 - Données source du graphique

Plage de données Série

(-8l

@ Moyenne de température
@ Maximum moyen

0 Minimum moyen

Plage de données : =Feuil 11$A$1:$M$4

Sérieen : @) Lignes

(©) Colonnes

[ Suivant > ][ Terminer ]

[ Annuler ] [ < Précédent ][ Suivant > ] [ Terminer

-

Rien & faire ici si tu as sélectionné les cellules, comme
indiqué & l'étape 9. Clique sur suivant.

11. Donne un titre au graphique. Indique le nom des axes.

/

Assistar\Graphique - Etape 3 sur 4 - Options de Gyﬂﬂue @]

Titres

I Quadrillage | Légende J/éjquethes de données | Table de données I

Titre du ique :

Température Drummondville

Axe des abscisses (X) :
MoisT

Axe des séries (Y) :

Axe des ordonnées (Z) :
Température |

Températu

Température Drummonduville

O Moyenne de
température

@ Maximum moyen

) le‘ |
E—

0 Minimum moyen

Annuler ] [<Erécédent ][ Suivant > ] [ Terminer

Mission possible en TIC e Julie Aubé et Suzanne Harvey « RECIT de la CSDC



12. Place le graphique dans la feuille.

\

Assistant Graphique - Etape 4 six4 - Emplacement du graphique ? @
Placer le graphique :

|. () sur une nouvelle feuille\ Graph1

s B

ELIE @ entantqubjetdans: |G - |

[ Annuler ] [<Erécédent]

13. Le graphique est inséré comme un objet dans la page. Tu peux le redimensionner
et le déplacer. «Etire-le» pour voir tous les mois.

w
Température Drummondville

30
20

@ Moyenne de
température

b Température

@ Maximum moyen
4 ] w |

O Minimum moyen Température Drummondville

@ Moyenne de
température

@ Maximum moyen

sy Température

O Minimum moyen

Y JFMAMJJASOND

MoisT

14. N'oublie pas de sauvegarder. Fichier > Enregistrer sous... ou Ctrl + S au clavier.
Peux-tu interpréter les données?

 Tu pourrais peut-étre comparer avec une autre ville? (Deux feuvilles dans le méme

fichier.)

Mission possible en TIC e Julie Aubé et Suzanne Harvey « RECIT de la CSDC



SCRAPBOOKING DIGITAL

AAAAA Avec PowerPoint

DES CHENES

1. Insérez le disque dans le lecteur et ouvrez une nouvelle présentation
(vide) PowerPoint

2. Enregistrez

3. Insérez un arriére-plan

Format > Arriére-plan...
Cliquez sur la fleche v | et sélectionnez Motifs et textures...

Onglet Image > Bouton Sélectionner une image...
Choisissez l'arriere-plan de votre choix
* Regarder dans : (cliquez sur la fleche et choisissez le disque)
» Choisissez votre theme
e Choisissez un papier (double-cliquez)
* OK
* Appliquer

4. Insérez les éléments décoratifs

Insertion

Image > A partir du fichier...

Choisissez I'image (double-cliquez)

Jouez avec lI'image (redimensionnement, rotation, etc.)
Répétez ces étapes jusqu’a ce que la page soit a votre go(t

5. Insérez des photos ou d’autres images

Assurez-vous que la barre d’outils image soit accessible
Clic droit sur I'image pour changer l‘ordre

Lorsque le montage est a votre go(t, groupez les éléments (plus facile
pour le déplacement, surtout lorsque I'on utilise des lettres).
On peut les dissocier au besoin.

Suzanne Havey (adapté de Sonya Roussy CS des Trois-Lacs) * février 2011



6. Pour écrire du texte

Insertion > Zone de texte

Ecrivez et mettez en forme le texte (police, couleur, grosseur, etc.)
Placez la zone de texte a I’endroit voulu

Jouez avec le bloc de texte (rotation, plans, etc.)

Petits extras

1. Pour changer le format des diapositives :

Fichier > Mise en page...

Cliquez sur la fleche \ V‘ et sélectionnez Personnalisé

Ex : 30 cm X 30 cm

2. Pour faire une image de votre diapositive :

Sur la diapositive : Fichier > Enregistrer sous...
Enregistrer dans : (D ou X)

Nom de fichier :

Type de fichier > JPEG ou GIF

Diapositive en cours uniquement

*x* N'oubliez pas d’enregistrer votre travail **x*

Amusez-vous!

Suzanne Havey (adapté de Sonya Roussy CS des Trois-Lacs) ¢ février 2011



2

4

Enregistrement a I'aide d'un microphone

Réglez le volume d'enregistrement.

& .

Faites un essai pour vérifier les niveaux.

5 Cliquez sur le bouton Enregistrer et captez
quelques secondes de son.

N Cliquez sur le bouton Arrét pour stopper

Trop fort
Supprimez la piste d’essai.

Enregistrez tout le texte d'un personnage, puis cliquez sur arrét. Prendre soin de laisser un
peu de silence AVANT et APRES chaque réplique.

Enregistrez autant de pistes qu'il y a de personnages. Nommez chaque piste pour vous
aider a faire votre montage.

Enregistrez le résultat: Fichier => Enregistrer sous.

I'enregistrement. / N

;4— MH
Trop faible Correct !

X|ristert  w| 1,0]

3
3
h

Déplacer la piste vers e bas

Faorme d'onde (dE)
Spectre
Hauteur (EAC)

ATTENTION: Il y a aura un dossier (_data) de créé ainsi que deux fichiers (.aup et .bak). Si vous voulez déplacer votre

enregistrement, vous devez déEIacer ensemble le dossier ainsi que les deux fichiers.

© Karine St-Georges
Cs des Chénes 2009



Exporter le montage en format wav ou en format mp3

Edition  Affichage Projet Generer  Effet Pour exploiter votre montage dans un autre logiciel, vous devez I'exporter
Mourveau Chrl+H dans un format universel.
Qe . ChrlH0
Fermer kel

Enregistrer le projek sous., ..

Praojets récents, ., »

Exporter an WAY. ., < Le format wav offre la meilleure qualité sonore mais occupe beaucoup de
place sur le disque dur.

Expatter comme MP3... Le format mp3 offre une qualité sonore acceptable et divise environ par 10
I'espace nécessaire sur le disque dur. Le mp3 est le format standard d'Internet.

Exporter comme Cgg Yorbis Le format Ogg Vorbis est un format libre. Il offre une qualité sonore Iégére-
ment supérieure au mp3 tout en occupant un peu moins d’espace. Il faut un
logiciel spécialisé pour lire ces fichiers, mais ce logiciel est gratuit.

Export Multiple... Si vous désirez télécharger Audacity, vous pouvez aller a I'adresse suivante:
T http://audacity.sourceforge.net/
Imprimer...

Pour exporter en mp3, vous devez installer un utilitaire nommé
Quikker LAME MP3 ENCODER. Il est possible de télécharger I'utilitaire au méme en-
: : : droit que le logiciel

NG Choisir un emplacement pour le fichier,
donner un nom au fichier et enregistrer.

Dang le fichier erpaorté, vos pistes seront mélangées en deus canaux stéréa

[ Me plus montrer cet avertizeement,

0K

Cli N
CIQUCZ SUTUIN,

© Karine St-Georges 11
Cs des Chénes 2009



Comic Life

Logiciel de création de bande dessinée

1. Tour d’horizon de Comic Life

Le mode Bibliotheques

o, e e 37 3 an B -
= = & P A A v & A~
rer Imprimer Courier  Zoom avant Zoom arritre Adapter  Fremier plan Arriere plan Style  Plus gros Plus petit  Coulsurs Polices  Personnaliser

S+ Modeles de page

|Inc\us: 00's Comic

CONSEIL.
Commencez
avec des cases
ou un modéle de
page.

Ajoutsz ensuite
d2s images aux
ssssss

- 11

Enfin, sjoutez.
Iz bulles depuis
2 palatre cu
bas.

-]
(IR

Etvoilal

HI
E|H
mu

Album: |128x128
i i

+ | = S

Barre d’outils personnalisable (menu Personnaliser).

La page de travail. Glissez les modéles de pages, phylactéres, textes et images.
Organisateur de pages. Permet de sélectionner et réorganiser I'ordre des pages.
Modeles de pages. Seize catégories disponibles dans le menu déroulant.

Zone des ressources d'images. Glissez I'image choisie dans la page de travail.

QUUIOIOIONC

Sélecteur de source d’'images.
» Photos : puise dans les albums locaux (sur I'appareil)
» Explorateur : affiche I'arborescence de votre disque dur. C’est a cet endroit qu’on peut voir
le contenu d’un DOC (disque optique compact ou CD).
» Capture : a partir d’'une caméra photo, d’'une caméra Web ou d’'une caméra intégrée.

(3

Commentaires, effets de lettrage et phylactéres. Glissez I'élément dans la page de travail.

Comic Life pour Windows page 3 RECIT de la CSDC = Suzanne Harvey



